
 

AutoCAD® Civil 3D® Pressure Networks: Building and 

Using Your Custom Parts Catalog 

 
Shawn P. Choisser - SPEC Services, Inc., Senior Principal Designer - Pipeline 
Stephen Avon - SPEC Services, Inc., Lead Engineer/Designer - Pipeline  

CV6527 

AutoCAD
®
 Civil 3D

®
 software’s Pressure Networks is great out of the box if you use mechanical or push-

on fittings, but what if you use welded or other fittings? Not to worry—you can build your own custom 
parts catalog. Learn how to create the 3D model needed for your custom part, how to export the data, 
and how to include it in your new catalog using Content Catalog Editor. Once your parts are in your 
catalog, we will learn how to create the pressure network parts list to create your pressure network. 
Finally, you will learn how to share your design with stakeholders using InfraWorks 360™ software. 

Learning Objectives 
At the end of this class, you will be able to: 

 Learn how to create a 3D model for your custom pressure network part 

 Create a new parts catalog using Content Catalog Editor 

 Set the Pressure Network catalog and create a Pressure Network Parts List 

 Share your pressure network using InfraWorks 360™ 

About the Speakers 

Shawn Choisser received his AA from Orange Coast College in California in 2002, and he is 

currently a senior principal pipeline designer for SPEC Services, Inc., in Fountain Valley, 
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with users in SPEC’s Pipeline Design Group to customize, implement, and train on workflows 

in order to integrate the multiple software platforms used. Shawn has been using AutoCAD® 

software since 1999 and he is an AutoCAD® Certified Professional. He started attending 

Autodesk University in 2002. 

Stephen received his bachelor’s degree in civil engineering and his master’s degree in 

Transportation Engineering from CSU, Pomona. He is now a lead pipeline engineer and 

designer for SPEC Services where he primarily designs oil and gas pipelines for various 

clients. He started attending AU in 2012 where he has been continually inspired by the work of 

those around him. Stephen has brought back many concepts learned from others at AU and 

implemented them at SPEC Services. Such concepts include pressure pipe networks, 

Infraworks, and 3D printing to name a few. Stephen is currently studying for his PE 

examination which has been a lifelong dream to attain. 
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Introduction 
Although Autodesk® AutoCAD® Civil 3D® comes pre-loaded with several pressure network part 

catalogs with a good selection of parts, they do not provide welded fittings used in the oil and 

gas industry.  This leaves two options: use the preloaded parts that are similar, but not exact; or 

create your own parts library.  The original Parts Builder tools that come with Civil 3D® are not 

very user friendly, but you are in luck.  The new tools that were included with the introduction of 

Pressure Networks in Civil 3D® 2013 have given users a friendlier environment to expand their 

parts catalog. 

The tools and commands in this presentation are, technically, undocumented commands.  If you 

search for these commands in the “Help” that is in Civil 3D® you will not find them.  

Documentation for using these tools can be found at “C:\Program Files\Autodesk…” This 

documentation, while a help to get going, does not cover some of the details we will discuss.  

Learn how to create a 3D model for your custom pressure network part 
The end goal of creating a 3D model is to create a .CONTENT file for importing your custom 

part into the catalog.  The .CONTENT file is created from the drawing file of the custom part.  

There are three items the drawing file will need to complete the creation of the .CONTENT file: a 

3D model, 2D line work representing the centerline of the part, and the connection points where 

other parts and pipes can connect to the part.  The PUBLISHPARTCONTENT command is 

used to create the .CONTENT file from your completed drawing file. 

TIP: Make a list of all the parts you need to make.  This helps make sure you do not miss a part 

and gives you an easy way to let others know what parts are in the catalog.  

Creating the 3D model 

The first step in creating a custom part is to create a drawing containing a 3D model of the part.  

The 3D model can be as simple as a cone for a concentric reducer or as complex as showing 

the flanges, body and actuator for a valve assembly. It is entirely up to you.  There are only a 

few conditions that need to be adhered to: 

 Drawing units must be inches or millimeters 

 Entire 3D model must be one solid (a mesh or surface will not work) 

When creating more complex models utilize the UNION command to ensure all your 

components are included in your solid. 

The following commands can be helpful while creating a 3D model: SWEEP, UNION and 

SUBTRACT.  Switching to the ‘3D Modeling’ workspace will provide quick access to these and 

other helpful modeling commands. 
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Creating the part centerline 

The centerline definition of the part must be created in order to create the .CONTENT file 

needed to import the part into the catalog.  This feature is needed to show the centerline when 

the part style displays it.  The centerline definition is usually a single line, but it can contain 

multiple centerlines (i.e., tee, concentric reducer, etc.). 

When creating the centerline definition with multiple centerlines, create a block from the line 

work.  The name of the block or insertion point is irrelevant, just be sure the line work is in the 

correct location and orientation relative to the 3D model. 

Another item to consider is if you are planning on using the SWEEP command to create the 3D 

model, make a copy of your centerline before executing the command.  The SWEEP command 

will remove the path from the drawing. 

Creating the connection points 

The next step in getting the 3D model ready is to define the connection points.  The connection 

points define where the part will connect to other parts in the pressure network. 

To create a connection point, use the INSERT command that is located on the Connection Point 

panel of the Insert tab of the ribbon (note: this is not the same command to insert a block).  

AUTODESKCONNECTIONPOINT is the command if you prefer to use the command line. 

The two elements you need to define when inserting the connection point are the location of the 

connection point and the direction the pipe will be connecting to the part. 

Creating a connection point: 

 Start the AUTODESKCONNECTIONPOINT command 

 Pick an object to add the connection point to 

o Select 3D solid 

 Pick the insertion point on the object 

o Select where to insert the connection point (usually the end of the centerline of 

the part 

 Pick the 1st point for the direction 

o Select a point that is on the direction of the part (I use the nearest object snap 

and pick a point along the centerline near the connection point) 

 Pick the 2nd point for the direction 

o Select an additional point that is on the direction of the part (I used the endpoint 

object snap and select the connection point insertion point) 

 Add Engineering Data [Yes/No] 

o This may be an option for future development, but currently the command ends 

regardless of which option you choose 
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Continue this process until all connection points on the part have been defined. 

Autodesk® AUTOCAD® CIVIL 3D® Help Definition 
Autodesk

®
 Connection Point (ACP): 

You can connect pipes to objects created by other programs including AutoCAD
®
 MEP

®
 and AutoCAD

®
 

Plant 3D
®
 using an Autodesk

®
 Connector (ACP) object. You can also create an ACP object to allow other 

programs to connect to AutoCAD
®
 Civil 3D

®
 pipe networks. 

 
You can connect to ACP objects that are attached as an external reference (Xref). 
ACP connector objects do not require Object Enablers from the program that created them to be installed. 

  

CONNECTION 

POINT 

PART 

CENTERLINE 

3D MODEL 
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Publishing the part 

The final step is to publish the part and create the .CONTENT file.  This will be accomplished 

using the PUBLISHPARTCONTENT command. 

Here are a few tips that I have learned from other classes that will help the part preview images 

in your catalog look great: 

 Make the drawing area square.  The drawing area will be used to create an image of the 

part; if the image isn’t square it will be resized to be square, distorting the look of the 

part. 

o Create a new drawing, draw a circle (size doesn’t matter), zoom extents and 

resize the AutoCAD window so all sides are touching the circle. 

 Close the drawing with the circle and open the drawing with your part. 

 Set an isometric view using the View Cube to give the parts a consistent look. 

 

      “Resize the workspace so the drawing area is square.” 

Now with the drawing open and your workspace set, it is time to create your .CONTENT file. 
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Type PUBLISHPARTCONTENT on the command line and follow the command line, it will guide 

you through the process: 

 Select the 3D solid representing the part 

 Select the line work that represents the centerline of the part (the 3D solid will 

temporarily disappear) 

 Specify the units of the model (drawing must be in inches or millimeters) 

 Specify the part type (i.e., tee, reducer, elbow, etc.) 

Once these steps have been completed the drawing will zoom extents, change the visualization 

style to Shades of Grey and have created an image of your part.   

 

The Select location to save .CONTENT file dialog box will appear and ask for the name and 

location of the newly created .CONTENT file.  Save the file and you are done. 
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Create a new parts catalog using Content Catalog Editor 
Now that you have the .CONTENT file of the new part, it is time to populate a new part catalog 

with the part(s).  This is done with an additional program that is installed with Civil 3D® called 

Content Catalog Editor. 

NOTE: The Content Catalog Editor that is installed with Civil 3D
®
 2015 only works creating parts without a 

.CONTENT file, pipes only.  Use the Content Catalog Editor from Civil 3D
®
 2014 to import the parts with a 

.CONTENT file into your catalog. 

The Content Catalog Editor runs outside of Civil 3D®.   To launch the program go to the 

Windows Start Menu -> All Programs -> Autodesk -> Autodesk Civil 3D 2014 -> Content 

Catalog Editor 
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Creating a New Pressure Network Catalog 

Once you launch the Content Catalog Editor you have the option to open an existing catalog or 

create a new one.  If you just need to add additional parts to an existing catalog, it is 

recommended to open the existing catalog and do a Save As on the catalog.  This gives you a 

back-up in case anything goes wrong with the edited catalog.  If you do not plan to use any of 

the parts in the existing catalog, creating a new one eliminates some clean-up later. 

TIP: If you plan on using the Content Catalog Editor frequently, use the Tools->Options to set the 

Startup option to “Open the last catalog” setting.  This will open the last catalog you were working on and 

save a few clicks. 
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Importing Parts 

Now that the new or existing catalog is open, it is time to import some parts.  When importing 

parts there are two options available: 

 With a .CONTENT file 

o Used to create new fittings or appurtenances  

 Without a .CONTENT file 

o Used to create new pipe  

Importing Fittings or Appurtenances – With .CONTENT file 

To add fittings or appurtenances to the catalog, launch Content Catalog Editor and open the 

catalog to which you want to add the part.  Select the Import Part icon on the toolbar. 

 

Within Catalog file section, select the “Import from .CONTENT file” option on the Import Part 

dialog box, browse to the location of the .CONTENT file you wish to import, select the file, and 

then choose Next. 
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The next section is Part Type.  Use the pull-down menus to select the correct values.  Currently 

“Water” is the only industry available.  The next field is the Part Type; choose the value from the 

available fields.  These fields are pre-determined; if the part type is not available, choose the 

most appropriate type.  Finally, select the Part Family Name.  This field is customizable; if this is 

the first part for the Part Family Name, type the family name.  If there have been similar parts 

added already, just select the appropriate family name. 

 

The third section is Model Properties. Fill in as much information as you can.  The items with 

an asterisk are required; everything else is optional.  The description is the name that will be 

given to the part when adding it to the parts list. 
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The section is Connection Points.  Fill in the required information and any other additional 

information you may have for the part.  Pay attention to the nominal diameter field, this field 

must match with any other pipe or fittings this part is attached to for the design check to 

function properly. 
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Once you have inputted all the required information select the Finish button and the part will be 

imported in the catalog. 

TIP: It is a good practice to save your catalog after you import a part.  If you refresh the catalog, any 

parts that have been imported since your last save will be removed. 

Importing Pipe – Without .CONTENT file 

To add pipe to the catalog launch Content Catalog Editor and open the catalog to which you 

want to add your pipe.  Select the Import Part icon on the toolbar. 

 
 
Select the “Without .CONTENT file” option on the Import Part dialog box, and then choose Next 
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The following sections are similar to importing with a .CONTENT file.  Fill in the required 

information and any additional information you may have. 
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Set the Pressure Network Catalog and Create a Pressure Network Parts List 

Now that you have the parts in your catalog, the final step before you can start using them is to 

set the pressure network catalog and create a parts list of the new parts.  If you have a set of 

parts you commonly use, define the pressure network catalog and parts list in your template.  

This gets you off and running when creating a new drawing. 

Setting the Pressure Network Catalog 

To set the pressure network catalog, expand the Create Design panel of the Home tab of the 

ribbon and choose “Set Pressure Network Catalog”. 

 

Once the Set Pressure Network Catalog dialog box appears, select the folder icon and navigate 

to the folder location where the .sqlite file is located.  If there is more than one catalog in the 

folder, use the drop-down to select your catalog. 
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Creating the Pressure Network Parts List 

Now that the Pressure Network Catalog has been set, it is time to create the parts list.  First, 

open Toolspace, if it is not already open. Go to the Settings Tab, about half-way down is 

Pressure Network.  Expand this group, right-click on Parts List, and select New. 

 

A dialog box will appear for the new parts list.  The first tab is the Information tab: give the parts 

list a name and add additional information you need.  The next three tabs will be used to add 

the parts. 
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To add a fitting select the Fittings tab (the Pressure Pipe and Appurtenances tab steps are 

similar), right click on the name of the parts list and choose “Add type…”   Once you have 

selected the type, select the part from the type you wish to add to the parts list. 

 

Now that the part has been added to the parts list, it is time to add the sizes you need.  To do 

this right click on the part “Add Size…”  Each slide you see listed represents a part that was 

imported into the parts list.  In the Add Fitting Sizes dialog box, choose the size(s) you want and 

add in the allowable deflection (if applicable).   

 

With the part now in the parts list, set the Style, Render Material and Pay Item for the part.  You 

can set this globally for all sizes or you can manually set these settings for each size if desired. 

Save the parts list….the parts are now ready for use in your Pressure Network! 
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Share your Pressure Network using InfraWorks 360™ 
Now that you have finished the design it is time to share the Pressure Network with 

shareholders to get there buy-in. To share the design with users that do not use Civil 3D® or do 

not want to have to read complicated drawings we will use Autodesk® InfraWorks 360™. 

Exporting the Pressure Network 

To create the .IMX file InfraWorks 360™ requires, we will use the Civil 3D® Export IMX 

command.  This can be found on the Export panel of the Output tab of the ribbon.  Civil 3D® will 

ask to save the file if you have not already.  Civil 3D® will save the file with the same name and 

location as the original file. 

 

Importing the Pressure Network into InfraWorks 360™ 

Now that you have created the .IMX file of your pressure network, it is time to import the design 

into InfraWorks 360™ to share with others. 

Start InfraWorks 360™, create a new or open an existing model. Select the InfraWorks icon to 

expand the Build, manage, and analyze your infrastructure model” menu, select “Create and 

manage your model” button to expand its menu. 
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Once the menu has been expanded, select Data Sources to Import and configure data for the 

model. 

 

This will open the Data Sources panel; default location opens on the right side of the 

workspace.  Use the Add Data Source pull down to select the Autodesk® IMX option.  Navigate 

to the location of the .IMX file and select it. 

 

  



AutoCAD
®
 Civil 3D

®
 Pressure Networks: Building and Using Your Custom Parts Catalog 

19 
 

Once you select the file, the Choose Data Sources dialog box will appear.  Select the PIPES 

data type and click “OK”. 

 

InfraWorks 360™ will process the file.  Once it has completed the file will show up in the Data 

Sources panel. Right-click on the file and select Configure, this will launch the Data Source 

Configuration window. 

 

  



AutoCAD
®
 Civil 3D

®
 Pressure Networks: Building and Using Your Custom Parts Catalog 

20 
 

You can use the Data Source Configuration window to adjust how the data is represented in the 

model.  See the Help menu in InfraWorks 360™ for more information on each tab. 

 

Conclusion 
Now you have the knowledge to create a Pressure Network Catalog with the parts that you use 

in your industry.  We are not limited to the standard parts that ship with Civil 3D®.  Once you 

have created the Pressure Network, the Civil 3D® IMX Export functionality allows you to share 

your design in a non-technical manner using Autodesk® InfraWorks 360™. 


